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Frequently Asked Questions
This document lists frequently asked questions about the HVRC CREATE software.
This document was last updated: $Date: 2016/04/25 09:56:44 $.

Questions
1.0 General
1.1 What is HVRC CREATE?
1.2 How much does CREATE cost?
1.3 What 3D geometry formats does CREATE support?

2.0 Getting Started
2.1 What are the minimum requirements for using CREATE?
2.2 Will CREATE run on my computer and operating system?
2.3 Does CREATE run on Windows XP?
2.4 Does CREATE run on Linux?
2.5 Does CREATE run on Mac OS X?
2.6 Where can I get 3D models from to add to the Model Bank??
2.7 How do I enable stereoscopic rendering of the 3D view?
2.8 Can I access a remote CREATE Server via a proxy?
2.9 I can't log onto a server!
2.10 I'm having trouble getting a freshly installed Server to work!

3.0 Problem Solving
3.1 Where should I sent bug reports?
3.2 My computer is slow. Is there anything I can do to improve performance?
3.3 My computer (or CREATE) crashes every time I run the CREATE tools!
3.4 The CREATE tools crash when I try to save a snapshot!
3.5 The whole user interface is flickering!
3.6 I have an ISO VRML97 model, but it won't load in the Model Bank Tool!
3.7 CREATE crashes while (or after) loading a large model!
3.8 I'm having problems communicating with a HVRC CREATE Server!

Answers
1.1 What is HVRC CREATE?
HVRC CREATE is a suite of tools for designing and testing room layouts with version management for tracking
design iterations. HVRC CREATE uses interactive 3D technology to enable designers to rapidly prototype and test
designs against ergonomic guidelines and recommendations, and further supports an iterative design process with
multiple participants, including end-users. Although it is designed for control room engineering, it can also be used for
other applications where the layout of an environment is important.
For an introduction to the system, see the Overview of CREATE Toolkit
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(http://create.ife.no/vr/products/create/download/pdf/Overview.pdf).

1.2 How much does CREATE cost?
The latest prices and licensing details are available on the CREATE product web pages at:
http://www.ife.no/en/ife/departments/software-engineering/products/create/priceslicensing

1.3 What 3D geometry formats does CREATE support?
ISO COLLADA/DAE, Google Earth KMZ, and ISO VRML97 are supported for 3D geometry import. Experimental
support is included for importing 3D geometry in LWO, OBJ, OGRE SCENE, and PLY formats.
Layout models can be exported from the Layout Tool in ISO COLLADA/DAE or ISO VRML97 formats.

2.1 What are the minimum system requirements for using CREATE?
The minimum recommended requirements for the CREATE Tools is:
2 GHz x64 Core Duo computer
4GB RAM
64-bit Microsoft Windows 7 or Mac OS X 10.8.3
3D Graphics accelerator card (or "discrete" graphics for a laptop) with at least OpenGL 3.3 support (>256MB
display memory is recommended)
A three-button mouse
Storage space requirements vary depending on the configuration but are typically 250 to 1GB for the "Tools"
and 250MB for the server. The server should have sufficient additional space to store your data. We would
typically recommend at least 10GB.
The software can be used with a two-button mouse. Use the alt-key on your keyboard in combination with the left
mouse button to simulate the middle mouse button if you do not have three mouse buttons.
The CREATE server does not display 3D graphics and does not require a 3D-capable graphics card.
Important: The CREATE Tools can run on computers with dynamic IP addresses issued by a DHCP server, however
the server (if intended for use as a networked system) should always be installed on a computer with a fixed IP
address. CREATE should also be able to function via a firewall, if necessary. To test if it works with your firewall, try
connecting to our CREATE demonstration server (create.ife.no) as guest (with password "guest"). Contact CREATE
Support if you are unsure about this. CREATE is primarily intended for use on secured intranet and extranets.

2.2 Will CREATE run on my computer and operating system?
In general, we support and provide installers for Mac OS X 10.8.3 or newer, and Microsoft Windows 7 or newer on
64-bit operating systems. If you need to run on a 32-bit processor then please contact CREATE Support -- we may be
able to provide a 32-bit installer. Linux installers can be provided on request.
Mac OS X Users: See "Does CREATE support Mac OS X?" below for additional information.
Linux Users: See "Does CREATE support Linux?" below for additional information.

2.3 Does CREATE run on Windows XP?
We no longer support Microsoft Windows XP.
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2.4 Does CREATE run on Linux?
In theory, yes, however we no longer provide installers for Linux as part of the standard release. We only officially
support recent releases of Ubuntu, and we normally only provide installers for x86 64-bit processors, but we can
provide custom installers for other processors (32-bit x86 and arm6) if necessary.
See also the question "Will CREATE run on my operating system?".

2.5 Does CREATE run on Mac OS X?
We only support OS X 10.8.3 Mountain Lion and newer.
See also the question "Will CREATE run on my operating system?".

2.6 Where can I get more 3D models to add to the Model Bank?
Many manufacturers and vendors of furniture and equipment provide models for architects and designers from their
web pages. Some also provide models via online databases such as the Trimble Warehouse. If models are not
downloadable in a format supported by the Model Bank Tool directly (i.e. COLLADA/DAE, ISO VRML, or KMZ)
then you can use a 3D modelling tools or a converter to convert the data. SketchUp files can normally only be read by
SketchUp but can be exported from SketchUp in COLLADA/DAE or KMZ format (as for producing models for
Google Earth), and this is typically the case for other proprietary formats such as MAX, where the original tool is
typically needed. Feel free to contact CREATE support for advice on converting data.
If you need to produce models yourself then the Layout Tool provides limited support for modelling internally, for
drawing walls with doors or windows, and for some common objects. This is intended primarily for modelling the
room and placeholders for objects (e.g. a cylinder may be used to represent a water cooler). To produce more
advanced models then a third-party 3D modelling tool is required. If you work for a vendor or manufacturer yourself
then your CAD department can probably assist you. Models can be exported from most CAD tools for use in
CREATE. Otherwise, we recommend using tools such as Blender (which is free) or commercial tools such as 3D
Studio Max, Maya or SketchUp for use with CREATE.
IFE can also produce or convert models for you as an additional service -- contact us for information on pricing, which
may be the most cost-effective alternative if you need to convert a large number of models or only produce a few
models.

2.7 How do I enable stereoscopic rendering of the 3D view?
First of all, you need a graphics card that supports advanced ("quad-buffer") stereoscopic rendering, and display
hardware that enables you to use it. We recommend using a computer with an NVIDIA QUADRO GPU.
In most cases you will first need to turn on stereoscopic rendering support for your graphics card via your operating
system's Display Properties control panel.
If you have that, then you can enable stereoscopic rendering via the Edit > Preferences... dialog from any of the
CREATE client tools. You will need to restart the CREATE tool for this option to take effect.
Note that enabling stereoscopic rendering has a significant effect on performance (in particular at higher resolutions),
so it is recommended that you disable stereoscopic rendering when you do not need it.
Known issue: Stereoscopic rendering is currently (2016) non-functional in the standard distribution of CREATE.
Contact CREATE Support for assistance if you require stereoscopic rendering support.
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2.8 Can I access a remote CREATE Server via a proxy?
If your computer is behind a firewall that requires you to use a proxy to connect to remote servers then you will
normally be able to access a remote CREATE Server by enabling HTTP proxy support in the CREATE client tools.
You can enable HTTP proxy support via the Edit > Preferences... dialog from any of the CREATE client tools. You
may need to restart the CREATE tool for this option to take effect.

2.9 I can't log onto a CREATE server!
Situation: No response from a remote server
If you are trying to access a freshly installed server that you have installed yourself then see the information below
about the situation of “Troubleshooting a freshly installed server”.
If you are using the Demo version of the Layout Tool, or are trying to access a remote server, first check that you have
a network connection that can access the server (e.g. create.ife.no). Try entering the address in a web browser to verify
that the server is online. If you are behind a proxy-based firewall, then see the previous question 2.8 for information. If
you are still unable to access the server at all, please notify the server’s operator. You may need the assistance of your
network administrator (or a network administrator at the remote site) if you are unable to access the server due to
security restrictions on your own or the remote network.
Note that in this situation you may get an immediate error message informing you that the server could not be
reached, or the tool may appear to hang. The tool has not crashed, but is waiting for a response. After a while, it will
either achieve a connection or it will give up and display an error.
Situation: A login dialog appears but you are unable to log on
If a login dialog appears but you are unable to log on then check the following:
1. The login name is case-sensitive – make sure that you enter it correctly. Your current user name for
Windows/Mac/Linux is shown as a suggestion, but may not be identical to your login name on the CREATE
server
2. Do you have a login name that is permitted to access the current server with the tool you are trying to log in
using?
a. If you are trying to use the User Tool, Guideline Tool, Model Bank Toll, or Project Management Tool,
then a user with User Tool (e.g. “admin”) access will first need to configure your user to give you access
to the tool you wish to use.
b. If you are trying to log onto the Layout Tool or Verification Tool, then make sure that a project has been
created (with the Project Management Tool) and that you have been assigned to a project as a Designer or
Reviewer.
3. Have you forgotten your password? If you have forgotten your password then a user with User Tool access can
reset it for you using the User Tool.
4. If the server does not have a valid license key installed (e.g. license expired or licence key not installed) then
you may not be able to access it with the tool you are using. The solution to this problem is to install a valid
license key file on the server.

2.10 I’m having trouble getting a freshly installed Server to work!
In most cases, installing a server is straightforward, involving running the server installer, requesting a license key for
the server information provided by the installer, and installing the key received. See the installation procedure,
described in the Quick Start document provided with the server, for details on installing and configuring a HVRC
CREATE Server for use. The known potential pitfalls to watch out for are covered in the installation procedure.
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Troubleshooting: Is there a web server running on the computer?
The following answer is aimed at Windows users. Users of Linux or Mac OS X should contact CREATE Support for
assistance as CREATE extends the existing web service on those platforms.
You won’t be able to access the CREATE Server if another web server is already running on the computer. If that is
the case then you must either run the CREATE Server on a different network port (contact CREATE Support for
instructions), configure the other server to support the CREATE scripts (assuming that the other server is an Apache
server) or turn off the other server and then restart the CREATE Server. The most commonly encountered situation
where this case occurs is where a user is unknowingly running a personal web server on their computer that was
installed when they installed or configured Microsoft Windows. If you try to access your computer’s server address (as
reported by the CREATE Server installer) in a web browser and you see a welcome-page for a Microsoft personal
server then you are in this situation and need to first turn off the Microsoft server. This can be done via the Windows
Start menu (Programs > Accessories > System Tools). You should then restart the CREATE Server by either restarting
your computer, or stopping/starting the Apache server, using the ApacheMonitor program in the Apache2\bin directory
of a CREATE Server installation.
Troubleshooting: Does your server have a permanent IP (network) address?
The CREATE Server has been designed to server data to workgroups collaborating on the design and evaluation of
room/building layouts. The server can be installed either as a standalone server (only accessible on the computer on
which it is installed) or as a network server. Most CREATE servers are installed as network servers, however, if you
are the only user of the software then it is possible to install the server without requiring a fixed IP-address (ie
“standalone”).
If used as a network server, then you must make sure that the computer’s address does not change. If the computer on
which you intend to install a CREATE server does not have a permanently fixed address then you will need to arrange
with your network administrator to permanently allocate an address to the server computer. If you have already
installed the server and been allocated a working key then you should ask your network administrator to reassign the
IP-address associated with the key to that computer on a fixed basis. You may need to restart your computer and/or the
CREATE Server if your network configuration is changed (see previous point, where the ApacheMonitor is
mentioned, for information on restarting the CREATE Server).
Troubleshooting Question: Are you are you running anti-virus software that is blocking or monitoring webtraffic?
Some anti-virus software blocks or filters web-traffic, so the anti-virus program settings should be adjusted to take into
account that you are running a Web server on your PC. While most anti-virus software will warn you that blocking or
filtering is taking place, this is not always the case and the result can be unpredictable behaviour, where some
communication between HVRC CREATE Tools (such as logging in) works and other communication (updating the
databases on the server) fail. Kaspersky Internet Security, for example, is know to silently filter some traffic,
preventing normal operation of HVRC CREATE Tools. Adjusting the anti-virus setting resolves this issue.

3.1 Where should I send bug reports?
Please send bug reports to create-support@ife.no.
If possible, please include a copy of the technical details from the CREATE About box (use the Save button in the
About window to save the details to a text file) when sending bug reports, and explain the actions taken that led to the
discovery of the bug.
Other information useful to us to include in a bug report:
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1.
2.
3.
4.
5.
6.
7.
8.

Product name and version
Severity of the bug
Is it reproducible?
Brief summary of the problem
Steps to reproduce it
Expected results
Actual results
Any other information or files that may help us reproduce and fix the problem

If you wish, we can keep you informed about the status of the bugs you report, and provide you with an "emergency
release" if necessary.
Please check the answers to questions in this FAQ first as the majority of problems reported are graphics card driver
issues or caused by anti-virus software.

3.2 CREATE runs too slowly on my computer. Is there anything I can do to improve
performance?
If the 3D view is running slowly on your computer, and it is not because the model is particularly detailed, then you
could try one or more of the following:
Avoid running other graphics or processor-intensive processes at the same time as using CREATE
Check that you are not accidentally running with stereoscopic rendering enabled
Reduce the resolution of the display (or don't run CREATE full screen on it) if you are using a very high
resolution display
If you are running on a computer with both "integrated" and "discrete" graphics options then check that you are
running with discrete graphics. if you are using a laptop that is not connected to a power source then it may
switch to integrated graphics to save battery.

3.3 My computer (or CREATE) crashes every time I run CREATE!
First, if the software regularly crashes or hangs then check if there are newer drivers available for your graphics card
from the card vendor. Most serious crashes reported to us are caused by driver problems that are, unfortunately,
beyond our control. Contact HVRC CREATE Support for advice, as it is normally possible to resolve the issue by
updating the driver and/or trying some of the tips outlined below.
In most cases, upgrading the graphics card drivers resolves this kind of problem.

3.4 CREATE crashes when I try to save a snapshot!
The cause of this is the same as for the question above. This was an issue in the past on early "integrated graphics"
chipsets that did not provide fully compliant 3D support. It could still be an issue if you are running on a computer
with limited 3D graphics support. Some computers (mostly laptops) provide a power-saving mode where integrated
graphics are used, so take care to use the best-performance option in order to use the best graphics capabilities of your
system.

3.5 The whole user interface is flickering!
On Windows-based computers with NVIDIA Quadro-based graphics cards, you may need to adjust the OpenGL
configuration of your display to prevent flickering of 2D user interface elements when the 3D view is refreshed. This
issue appears to have been resolved in Windows 8 and later but was common on XP. The following procedure can be
used to reconfigure the display:
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1.
2.
3.
4.
5.
6.

Go to the Settings tab of the Display Properties control panel
Click on the Advanced button to display the NVIDIA Quadro Properties
Go to the Quadro tab
Select the OpenGL settings
Set the "Buffer-Flipping Mode" option to "Use Block Transfer"
Click on OK in each of the control panel windows to dismiss them

3.6 I have an ISO VRML97 model but it won't load in the Model Bank Tool!
Most models exported from 3D modelling packages will load fine in the Model Bank Tool, but may not look as you
expect. The most common reason for this is that the origin of the model is not where it should be (typically, the centre
of the bottom of the model), or the model has been exported with the incorrect scale (1 VRML unit is 1m). See the
Model Bank Tool User Guide for details.
If you use the "Import Model" option in the File menu of the Model Bank Tool then the model can be modified during
the import process (using "Open..." loads it as-is). This enables you to correct a number of common issues with models
without have to manually modify the model in a 3D modelling tool. The comments below are therefore directed at
those producing VRML data themselves that wish to produce as clean VRML code as possible.
The model loading mechanism that we use is strict (we don't want you to be able to add bad models to the Model
Bank) and therefore rejects files with any errors. As we only support VRML geometry, if your VRML file contains a
script that it depends on to generate geometry then it will not draw correctly.
If you are using 3D Studio Max, then make sure that you have a recent VRML exporter. Early exporters distributed
with 3D Studio are known to export files with a number of errors. Contact CREATE Support for advice.
Many VRML-exporters produce code that contains illegal characters in the VRML file, which prevent the file from
being loaded using a strict VRML importer. You should avoid using characters that are not letters or numerals when
naming objects and materials. If this is not possible then we have a Perl-script available for download on our website
(in the Products area), that can be used to fix such VRML files. If you are using the same computer as a HVRC
CREATE Server then you can execute the script from a command-line terminal using the copy of Perl bundled with
the server (typically C:\CREATE\Perl\bin\perl.exe). On Unix-like platforms, Perl is typically preinstalled, so the script
can be executed from a shell terminal.
We recommend using Chisel to optimise the VRML code. Chisel is a tool developed by Trapezium LLC, which is now
in the public domain. A copy of Chisel can be freely downloaded from our website. Chisel can also fix issues such as
illegal characters (see previous paragraph) and inefficiencies in VRML-data exported from SketchUp. When exporting
models from SketchUp, we recommend exporting as COLLADA/DAE rather than VRML.

3.7 CREATE crashes while (or after) loading a large model!
Note that memory management in CREATE 4 is significantly more efficient than in 3.x so users of CREATE 4 should
not experience this problem unless the model is exceptionally large (over 1 GB).
The most likely reason for this is that CREATE is running out of memory as the model is too large to fit into your
computer's memory. The most effective solution is to optimise the model. If it has been exported from a CAD system
then check for export options that enable you to reduce the number of triangles generated when tessellating the model.
There are tools available that can reduce models after they have been generated, such as Chisel (see above), although
the best results are usually obtained by optimising the output when it is created.
CREATE has been preconfigured to give a balance of performance and memory consumption that should work well
for the majority of users, however if you attempt to load very large models (file size and/or number of triangles) then
CREATE may run out of memory. This is especially an issue if you attempt to create multiple copies of very large
models in memory. If you are running on a computer with more than 16GB RAM and need to be able to load larger
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models than the default configuration of CREATE permits then please contact CREATE Support to discuss your needs
as we may be able to provide you with a customised installer.

3.8 I'm having problems communicating with a HVRC CREATE Server!
If you are able to log onto a HVRC CREATE Server but some communication with the server is failing, then the most
likely reason is that you are running anti-virus software that is filtering the communication. See the "troubleshooting"
note "Question: Are you are you running anti-virus software that is blocking or monitoring web-traffic?" in questions
2.12 above.

